Integration of Remote Terminal Units via DNP3 protocol in PCS 7 TeleControl

SIMATIC PCS 7 TeleControl

Application Example • November 2012
Siemens Industry Online Support

This article is taken from the Siemens Industry Online Support. The following link takes you directly to the download page of this document:


Caution
The functions and solutions described in this article confine themselves to the realization of the automation task predominantly. Please take into account furthermore that corresponding protective measures have to be taken up in the context of Industrial Security when connecting your equipment to other parts of the plant, the enterprise network or the Internet. Further information can be found under the Item-ID 50203404.


You can also actively use our Technical Forum from the Siemens Industry Online Support regarding this subject. Add your questions, suggestions and problems and discuss them together in our strong forum community:

http://www.siemens.com/forum-applications
SIMATIC PCS 7 TeleControl
TeleControl Protocol DNP3

Application Example

1 Automation task and solution
2 Installation of used Software
3 Creating a Project and Loading the PC Station
4 SINAUT DNP3 Configuration
5 Loading the Project in CPU and TIM
6 PCS 7 TeleControl with DBA
7 Configuration of Further AS Objects
8 Literature
9 History
Warranty and liability

Note

The Application Examples are not binding and do not claim to be complete regarding the circuits shown, equipping and any eventuality. The Application Examples do not represent customer-specific solutions. They are only intended to provide support for typical applications. You are responsible for ensuring that the described products are used correctly. These application examples do not relieve you of the responsibility to use safe practices in application, installation, operation and maintenance. When using these Application Examples, you recognize that we cannot be made liable for any damage/claims beyond the liability clause described. We reserve the right to make changes to these Application Examples at any time without prior notice. If there are any deviations between the recommendations provided in these application examples and other Siemens publications – e.g. Catalogs – the contents of the other documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us – based on whatever legal reason – resulting from the use of the examples, information, programs, engineering and performance data etc., described in this Application Example shall be excluded. Such an exclusion shall not apply in the case of mandatory liability, e.g. under the German Product Liability Act ("Produkthaftungsgesetz"), in case of intent, gross negligence, or injury of life, body or health, guarantee for the quality of a product, fraudulent concealment of a deficiency or breach of a condition which goes to the root of the contract ("wesentliche Vertragspflichten"). The damages for a breach of a substantial contractual obligation are, however, limited to the foreseeable damage, typical for the type of contract, except in the event of intent or gross negligence or injury to life, body or health. The above provisions do not imply a change of the burden of proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts hereof is prohibited without the expressed consent of Siemens Industry Sector.
Table of contents

Warranty and liability .................................................................................................................. 4

1 Automation task and solution ............................................................................................... 7
  1.1 Automation task ................................................................................................................. 7
  1.2 Solution ............................................................................................................................. 9
  1.2.1 Project description ........................................................................................................ 11
  1.2.2 Hardware and Software components used ............................................................... 12
  1.2.3 Your benefits at a glance ............................................................................................ 13
  1.2.4 Required knowledge ..................................................................................................... 13

2 Installation of used Software ............................................................................................... 14

3 Creating a Project and Loading the PC Station .................................................................... 15
  3.1 Creating a Project in the SIMATIC Manager .................................................................. 15
  3.2 Configuration of the Remote Terminal Unit ................................................................. 15
  3.3 Configuration of the Engineering Station ....................................................................... 19
  3.4 Configuration of the Operator Station ............................................................................ 21
  3.5 Configuration in Netpro .................................................................................................. 22
  3.6 Configuration and Loading of the SIMATIC PC Station .................................................. 24

4 SINAUT DNP3 Configuration ............................................................................................. 26
  4.1 Configuration SINAUT connection .............................................................................. 26
  4.2 SINAUT connection nodes ............................................................................................ 27
  4.3 Configuration of SINAUT Objects .................................................................................. 28
  4.4 Save and compile of System Data Blocks (SDBs) and Data Block (DBs) ....................... 31

5 Loading the Project in CPU and TIM .................................................................................. 32

6 PCS 7 TeleControl with DBA .............................................................................................. 34
  6.1 Create a new DBA project ............................................................................................... 35
  6.2 Inserting the SINAUT DNP3 components ...................................................................... 39
  6.3 Creating the Plant Hierarchy in DBA ............................................................................. 43
  6.4 Creating an Instance of the Type BitAlarm ..................................................................... 45
  6.5 Compile DBA project ...................................................................................................... 47
  6.6 OS Runtime Test ............................................................................................................. 48

7 Configuration of further AS Objects ..................................................................................... 49
  7.1 Creating the Object "Analog Value" ............................................................................... 50
  7.1.1 SINAUT - Object Configuration .............................................................................. 50
  7.1.2 DBA - Instance Configuration .................................................................................... 51
  7.2 Creating the Object "Command" ..................................................................................... 53
  7.2.1 SINAUT - Object Configuration .............................................................................. 53
  7.2.2 DBA - Instance Configuration .................................................................................... 54
  7.3 Creating the Object "Counter" ......................................................................................... 56
  7.3.1 SINAUT - Object Configuration .............................................................................. 56
  7.3.2 DBA - Instance Configuration .................................................................................... 58
  7.4 Creating the Object "Setpoint" ......................................................................................... 59
  7.4.1 SINAUT - Object Configuration .............................................................................. 59
  7.4.2 DBA - Instance Configuration .................................................................................... 62
  7.5 OS Runtime .................................................................................................................... 63
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Literature</td>
<td>64</td>
</tr>
<tr>
<td>8.1</td>
<td>Bibliographic References</td>
<td>64</td>
</tr>
<tr>
<td>8.2</td>
<td>Internet Links</td>
<td>64</td>
</tr>
<tr>
<td>9</td>
<td>History</td>
<td>65</td>
</tr>
</tbody>
</table>
1 Automation task and solution

1.1 Automation task

Overview

Various branches of industry require monitoring and controlling of plants separated by open ground and their processes from a central point. Remote controlled systems are widely used for this purpose. Fast and secure data transfer constitutes the basis for a successful operation of these systems.

Remote Control Systems realize the data transfer between the remote control center and the process-oriented remote terminal units (RTUs) for local automation using special telecontrol protocols.

They manage secure and faultless data transfer via WAN, even for small band widths and poor transmission quality.

Requirements

This task does not only require short data transmission times, but also efficient protection of the telegrams against:

- Undetected bit errors
- Unknown telegram error, resulting from
- Synchronization errors
- Undetected data losses
- Telegram falsification
• Separation or distortion of connected data

This especially applies to event-based telegrams via transmission channels with a limited band width and uncertain noise behaviour.

As irregular bit strings are combined for data transmissions, no encoding restrictions are allowed.

Typical Fields of Application

<table>
<thead>
<tr>
<th>Machine or sector</th>
<th>Task</th>
<th>Figure</th>
</tr>
</thead>
</table>
| Oil and gas industry                   | • Compressor, pressure reduction, transfer, slide gate valve and measuring stations in gas distribution systems  
• Pump and slide gate valve stations in oil pipelines  
• ….                                                                                     | ![Image](image1.png) |
| Water industry                         | • Water well, pump and slide gate valve stations in water supply networks and irrigation systems  
• Stormwater overflow tanks and lifting equipment in wastewater systems  
• …                                                                                     | ![Image](image2.png) |
| Energy management, environmental protection and traffic | • Facilities for power generation and distribution  
• District heating  
• Traffic management systems  
• …                                                                                     | ![Image](image3.png) |
1.2 Solution

Via different telecontrol protocols the remote control center in SIMATIC PCS 7 allows controlling and monitoring of widely distributed remote terminal units (RTUs) via serial or Ethernet TCP/IP communication connections. The control center integrated in the Operator System of the process control system by means of the SIMATIC PCS 7 TeleControl acts as a "Master" within the telecontrol communication.

Figure 1-2: System architecture

Content of Application

The short description for the configuration of the RTU (Remote Terminal Unit) gives you a first overview on the PCS 7 TeleControl with the Telecontrol Protocol DNP3. The purpose of this application is to support you when independently creating a simple project.

The project may be configured on an already existing SIMATIC PC station. This application is intended for beginners with PCS 7 TeleControl, whose tasks are assigned to the following areas:

- Configuration
- Commissioning
Implementation

Within this application, examples for the following object types will be created:

- BitAlarm
- Analog value
- Command
- Count value
- Setpoint value

The first chapters describe the proceeding for the configuration of DNP3 communication between RTU and OS and an AS object of the type BitAlarm using the SIMATIC Manager, the SINAUT configuration tool, and DBA. Subsequently, you will find the configuration of further object types.
1.2.1 Project description

The following simple example explains the configuration procedure. The sample project consists of an ES/OS and an RTU, which communicate with each other via the DNP3 protocol.

Schematic representation

The schematic representation below shows the most important components.

---

### Note

The above design can only be effected using real hardware. Due to the DNP3 protocol, a communication via simulators (such as PLCSim) is not possible.

### Connection nodes

The subscriber numbers are allocated by the connection configuration, but should be changed especially for purposes of better maintainability and standardization of the plant.

---

<table>
<thead>
<tr>
<th>Subscriber</th>
<th>Subscriber number</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU 315-2 DP</td>
<td>1</td>
</tr>
<tr>
<td>TIM 3V-IE DNP3</td>
<td>1001</td>
</tr>
<tr>
<td>WinCC Appl.</td>
<td>2001</td>
</tr>
<tr>
<td>DNP3 Master</td>
<td>2010</td>
</tr>
</tbody>
</table>
1.2.2 Hardware and Software components used

The application was created with the following components:

### Hardware components

<table>
<thead>
<tr>
<th>Component</th>
<th>Qty.</th>
<th>MLFB/order number</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU 315-2 DP (V2.6)</td>
<td>1</td>
<td>6ES7 315-2AG10-0AB0</td>
<td></td>
</tr>
<tr>
<td>TIM 3V-IE DNP3</td>
<td>1</td>
<td>6NH7 803-3BA00</td>
<td></td>
</tr>
<tr>
<td>Optional Inputs and Outputs</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DI/DO16x24V/0.5A</td>
<td>1</td>
<td>6ES7 323-1BL00-0AA0</td>
<td></td>
</tr>
<tr>
<td>AI8x16Bit</td>
<td>1</td>
<td>6ES7 331-7NF00-0AB0</td>
<td></td>
</tr>
</tbody>
</table>

### Standard software components

<table>
<thead>
<tr>
<th>Component</th>
<th>Qty.</th>
<th>MLFB/order number</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC PCS 7 TELECONTROL V7.1 SP2</td>
<td>1</td>
<td>6DL5000-8AF17-0XA5</td>
<td></td>
</tr>
<tr>
<td>SINAUT ST7 ENGINEERING-SOFTWARE V5.1</td>
<td>1</td>
<td>6NH7997-0CA51-0AA0</td>
<td></td>
</tr>
<tr>
<td>SIMATIC PCS 7 V7.1 SP3</td>
<td>1</td>
<td>6ES7658-5AA17-0YA5</td>
<td>Optionally also: Microsoft Windows Server 2003 including Service Pack 2</td>
</tr>
<tr>
<td>Microsoft Windows XP Professional including Service Pack 3</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
1.2.3 Your benefits at a glance

SIMATIC PCS 7 TeleControl combines the automation of central plants and monitoring of decentrally distributed processes in one control center.

- Plant automation and remote control in a single integrated system
- Uniform visualization reduces the risk of operating errors
- Integrated engineering and simple data management
- Reduced cost of installation, commissioning and maintenance

1.2.4 Required knowledge

Basic knowledge of the process control system SIMATIC PCS 7 is necessary.
2 Installation of used Software

NOTE The complete installation is effected on the Engineering Station.

Installation procedure

The following table shows the installation steps to perform.

Table 2-1

<table>
<thead>
<tr>
<th>No.</th>
<th>Action</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Installation of the operating system</td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>Installation of PCS 7</td>
<td></td>
</tr>
<tr>
<td>3.</td>
<td>Installation of the PCS 7 TeleControl Software</td>
<td></td>
</tr>
<tr>
<td>4.</td>
<td>Installation of the SINAUT ST7 Engineering Software</td>
<td>The software package is a work package, which can be used for SINAUT projects without any licensing procedure.</td>
</tr>
<tr>
<td>5.</td>
<td>Installation of authorizations and licenses</td>
<td></td>
</tr>
</tbody>
</table>

Note For a detailed description, please refer to the "TeleControl Setup Guide". 
3 Creating a Project and Loading the PC Station

3.1 Creating a Project in the SIMATIC Manager

The first step is to create a new project in the SIMATIC Manager. The respective plants use this Project as directory for all project planning data.

1. Create a new project in the SIMATIC Manager.  
   File > 'New Project' Wizard…

2. Select a project type (Multiproject), the respective directory, and a project name. 
   e.g. name: D:\PCS7TCGS_DNP3  
   e.g. path: TCMP_DNP3

3. Select "Multiproject > Create Multiproject" from the context menu to create a new project within Multiproject.

4. Determine project name and project directory within the displayed dialog. 
   e.g. name: TC_DNP3  
   e.g. path: D:\PCS7TCGS_DNP3

3.2 Configuration of the Remote Terminal Unit

A so called RTU (Remote Terminal Unit) is a combination of an automation station and a telecontrol coupling.

1. With the context menu of the project, add a SIMATIC 300 station for the RTU selecting.  
   Insert New Object > SIMATIC 300 Station

2. Rename the station.  
   e.g. RTU-DNP3

3. Start the configuration program "HW Config" by double-clicking the entry "Hardware" of the inserted station. Within this program, you can insert the hardware components of the RTU.

4. Insert the modules of the modules catalog into the station. Refer to chapter "Hardware and Software components used".
Parameterization of the modul – TIM 3V-IE DNP3

The TIM (TeleControl Interface Modul) module will be parameterized for time synchronization and network parameters over a dialog. The other default settings can be accepted without changes.

1. Open the configuration-dialog for the TIM by double-clicking the TIM module.
2. Select the tab "Time Service" to configure the time synchronization of the TIM module.
3. The time synchronization of the TIM module is effected via the network. 1 minute cycle time is recommended.
4. Select the tab "Interfaces" to define the network parameters.
5. For entering the TIM IP address, open the "Properties..." dialog.
   e.g.:
   IP: 192.168.168.3
   Subnet mask: 255.255.255.0

6. To create a new Industrial Ethernet bus for communication between the subscribers, open the "New..." dialog.

7. Within this dialog, only the name needs to be adapted.
   e.g. RTU-DNP3

8. Confirm with “OK”.

9. Open the “DNP3 parameters...” dialog and check the drop down list for “YES” for the “Unsolicited reporting”. So the OS gets unsolicited all messages.

10. Finally confirm your settings with “OK”.

**Address Analog Module**

The start address of the inputs has to be adapted with the analog module, so that the analog values at the analog module are within the address range of the OB1 process image of the CPU.

Figure 3-1: Address the AI-module in HW-Config

1. Open the object properties of the module "AI8x16Bit" by double-clicking on it.
2. Under the tab "Addresses", assign a user-defined start address (<113).
3. Save and compile the address before closing the "HW-Config".

*Station > Save and compile*
3.3 Configuration of the Engineering Station

After the RTU has been created, the next step is to configure the ES via a SIMATIC PC Station, which also has to be created.

1. Use the context menu to add a new PC station to the project.
   *Insert New Object > SIMATIC PC Station*

2. Rename the PC station according to the computer name.
   e.g. ES…

3. Start the configuration program "HW Config" by double-clicking the entry "Configuration" of the inserted station.

4. Now insert a "WinCC Application" from the module folder into slot 1.

5. Subsequently, insert a communication module "IE-General Interface" from the module folder into slot 2.
6. Via the object properties of the module, assign the IP address of the PC in the parameter settings.

7. Create a new Subnet "Terminalbus" with the button "New…".

8. Compile the configuration via the menu command before closing the HW Config.
   Station > Save and Compile
3 Creating a Project and Loading the PC Station

3.4 Configuration of the Operator Station

As stand-alone system, the ES can additionally be used as OS. The following configurations still have to be performed.

1. Rename the created OS(1).
   e. g.: OS_DNP3

2. Open the OS in the "WinCC Explorer".
   context command > Open Object

3. Start the "Project Editor" once in the "WinCC Explorer".

4. Open "Tag Logging" for later archiving of the analog values.
5. Use the "Archive Wizard" to create a new process value archive named "SystemArchive".
   Archives > Kontextmenü > Archive Wizard…

6. Close the "WinCC Explorer".

### 3.5 Configuration in NetPro

Graphical configuration of network topologies can be effected via NetPro. During the process of network configuration, networks and stations can be integrated into a new project, parameterized and linked. The ES/OS and the RTU have already been created and linked in the previous steps.

1. Start "NetPro", e.g. by double-clicking the entry "Connections" of the WinCC application.

2. Insert a new station of the type "Other Station" via drag&drop into the project. View > Catalog

3. You can rename the station within the object properties of "Other Station". 
   z.B.: DNP3_Master

![Properties of the Other Station dialog box showing the name, project path, storage location, and comment fields with default values.](image-url)
4. Under the tab "Interfaces", click the button "New..." to create a new interface of the type "Industrial Ethernet".

5. Connect the "DNP3_Master" and the "Plant bus" using the IP address of the PC.
   > 192.168.168.1

6. Compile and save the configuration and close "Netpro".
   Menu command > Network > Save and Compile

Figure 3-2: Overview NetPro
3.6 Configuration and Loading of the SIMATIC PC Station

The PC station is configured and loaded within the SIMATIC Manager.

1. Select the PC station and open the object properties via the context menu.
2. Tick the checkbox for "Computer Name identical to PC station name".
3. Calling the context menu of the PC station again configures the PC with the data from the HW Config.

*PLC > Configure…*
4. Once the appropriate PC has been selected in the configuration dialog, start the configuration via the button “Configure...”.

5. Loading the PC station is again effected via the context menu.

   **PLC > Download**

6. Check the result in the Component Configurator.
4 SINAUT DNP3 Configuration

Before you start configuring the telecontrol protocol DNP3, please ensure that your SIMATIC PCS 7 project has been opened.

1. Start the SINAUT configuration tool.
   
   Menu command > Start > SIMATIC > SINAUT ST7 > SINAUT ST7 Configuration

2. Select your PCS 7 project and open the dialog "SINAUT Configuration Tool".

3. For configuration of SINAUT DNP3, select the option "Connection Configuration".

4.1 Configuration SINAUT connection

Configure those connections, which are really required for the plant communication and which shall be used. For this purpose, the possible connections (right side of the window) need to be moved into the left side of the window of the configured connections.

1. Select the connection "DNP3_Master → RTU_DNP3" in "possible connections".

2. And add it to the "configured connections".

context menu of the connection > Add
4.2 SINAUT connection nodes

The subscriber numbers were assigned by the connection configuration. For maintainability and standardization it is necessary to change the subscriber numbers.

1. Call the Subscriber Administration.

2. To change the subscriber number, select the desired subscriber and make his subscriber number editable.
   *Context menu > Change subscriber no.*

3. Assign the connection numbers according to the Table 1-2 in chapter 1.2.1 > Connection nodes.

![Image of Subscriber Administration interface]
4.3 Configuration of SINAUT Objects

Add data object

Before TIM and CPU can be tested, at least one "TD7onTIM" object must have been added to the project.

1. First configure an AS object of the type BitAlarm.

2. In the first step, select the option "TIMs with TD7onTIM > 1001 / RTU_DNP3" from the window "Subscriber types".

3. Open the "TD7onTIM" library.

4. Here select the standard object type "Bin04B_S" and insert it into the project.

Activate channel

Enable the respective channel within the Bin04B_S object and configure its input address. The Bin04B_S object is used for the transfer of the switch status from the RTU to the OS.

1. Select the added "Bin04B_S" object.

2. Enable the check box "Channel active" to enable the channel "InputByte_1".
3. Select the check box "Input" for Memory Area and for the address "Address [Byte] = 4" according to the I-address of the module DI16 in the HW configuration.

Assign communication partner

In the last step, assign a communication partner to the Bin04B_S object.

1. For this purpose, select the subscriber 1001 (RTU_DNP3) and select object 1 (Bin04B_S).
2. Under "Available partners", select the DNP3_Master and transfer the communication partner via the button to the "Selected partners".
4.4 Save and compile of System Data Blocks (SDBs) and Data Block (DBs)

Following options for generating System Data Blocks and compilation the TD7-source data are made.

1. Save the project.
   *menu command* > SINAUT > SAVE

2. Confirm the message regarding intermediate external changes with "OK".

3. In the following dialog, the presets can be accepted without any changes and confirmed by pressing the button "OK".

4. The status is issued after conclusion of the process.
5 Loading the Project in CPU and TIM

At first creating a PG/PC interface on the network card, via which the TIM is connected.

1. Use the SIMATIC Manager to edit network interfaces.
   - PLC > Edit Ethernet Node

2. Search for existing subscribers in the network by pressing the button "Browse".

3. Select the TIM 3V-IE DNP3 and confirm by pressing "OK". This takes you back to the dialog "Edit Ethernet Node".
4. Enter the respective IP address and subnet form of the TIM from the hardware configuration there.
   *e.g.: IP-address: 192.168.168.3
   Subnet mask: 255.255.255.0*

5. Press the button "Assign IP Configuration".

![Ethernet node configuration](image)

6. Select the RTU in the "SIMATIC Manager" and start the data transfer.
   *menu command > PLC > Download*

7. Confirm the following dialog by clicking on "YES".

The CPU and TIM have to be stopped during the loading process and restarted afterwards.

**Note**

Loading the RTU is effected via TIM. As the TIM itself is loaded first and subsequently performs a restart, loading the RTU might be interrupted and has to be repeated after a restart of the TIM. Alternatively, you can wait until the TIM has been restarted and then load the RTU.

If you should wish to wait with the further loading process until the TIM is running again, we recommend to process the appearing message asking for your permission to overwrite an already existing module (e.g. OB1) only after the TIM restart has been finished and the TIM is completely up and running again. While loading, you may also stop the TIM and the CPU manually and restart them also manually after completion. Thus, you will avoid an automatic restart of the TIM during the loading process.
PCS 7 TeleControl is a software package consisting of the engineering software Data Base Automation (DBA), the DBA Runtime Framework and a library with OS icons, OS faceplates, and OS diagnostic displays for the remote terminal units of a telecontrol system.

The engineering software DBA automatically generates the OS database including picture hierarchy, required variables, alarms, alarm messages, and alarm priorities as well as the specific faceplates and block icons.

DBA provides a graphic engineering interface with 4 areas.

To create a new TeleControl project, proceed as follows:

1. Create new DBA project
2. Insert the PC station
3. Insert the OS server application
4. Insert the physical SINAUT DNP3 components
5. Create the Plant Hierarchy (PH)
6. Create the instances and assign them to the PH
7. Compile the DBA project (Compile)
Before the DBA project can be created, the PCS 7 project must be created in the SIMATIC Manager and the OS server configuration must be completed. Especially the archive setup must be complete. During DBA configuration, data from the PCS 7 project are read out.

6.1 Create a new DBA project

Add PC station

1. Start the DBA tool via the start menu.
   *Start > SIMATIC > DBA > PCS 7 DBA*

2. Create a new project.
   *menu command > File > New Project*

3. Save your project.
   *File > Save Project*

**NOTE**
It is recommended to save the DBA project within the project folder of the WinCC project under the name "DBA_DNP3".
4. Insert the ES/OS under the tab "PC Station View".
   *context menu > Add PC Station*

5. Under "Computer Name", enter the name of the PC.

---

**Add OS server application**

The next step is to adapt the OS properties.

1. Insert an OS server application via the tab "PC Station View".
   *context menu > Add Application*
2. Rename it as "OS_DNP3". Furthermore change the settings for APL in the field "Value" to "Yes" by using the drop down list.

3. Select the ".mcp" project file in the "Value" field of the "Offline MCP-File". Use the "…"-button to insert the link to the WinCC project.
4. As "Link Address", enter the subscriber number of the "DNP3_Master" according to the SINAUT subscriber configuration (Table 1-2, Connection nodes).

5. Via the context menu of the OS application the settings are read out of the WinCC project.
   context menu > Refresh OS Cache

6. After the read-out, a dropdown menu will appear in the column "Value" of the "Tag Logging Archive". Use this menu to select the process value archive "SystemArchive".

The OS configuration is now completed.
6.2 Inserting the SINAUT DNP3 components

The Basic Library of PCS 7 TeleControl provides, among others, various Diagnostic Typicals. These are for displaying and operating the hardware components. The Diagnostic Typicals are created automatically and do not require any additional configuration efforts. They only need to be assigned to the Plant Hierarchy.

To configure the physical components, please open the tab "AS View" in the DBA tool.

Configuration of TIM 3V-IE DNP3 as communication partner in DBA

1. To create a new AS station, open the context menu in the area "Components".

2. Here add a "DNPCONN" for the TM.

3. Select an optional "AS NODE" name.
   e.g. DNP3_Connect

4. Select TCP as "Protocol Type".
5. The "Connection Address" corresponds to the TIM IP address of the HW configuration.
   > 192.168.168.3

6. Press the button "Configure Connection Parameters" to configure the connection parameters.

7. Set both "Index Size" and "Start/Stop Size" to "1 Octet" and deactivate "Close Connection on Timeout".

8. Confirm the settings with "OK".

**Configuration of RTU-CPU in DBA**

1. Add another AS source node.
   
   context command >Add AS Source-Node…

2. For this purpose, select the type "DNPRTU".
3. Assign an optional "AS Node" name.
   e.g. DNP3_RTU

4. Press the button "Configure Connection" to open the respective dialog and use the SINAUT-subscriber number of the CPU (Table 1-2, Connection nodes) as "Link Address" for "Connection1".

5. Confirm the entry with "OK".
6. Press the button "Configure Parameters" and enable "Unsolicited Responses > class 1".

7. Confirm the with "OK".

NOTE: According to settings for the TIM modul (17) and partner configuration in SINAUT is necessary.
6.3 Creating the Plant Hierarchy in DBA

Create the Plant Hierarchy in the DBA within the "Plant View". When creating new plant areas, the respective picture areas are automatically created. The plant areas may be given user-defined names.

1. Create two new plant areas (e.g. Diagnostic and RTU) within the "Plant View".
   context menu > Add Folder

2. Assign both plant areas to the OS server.
   context menu > Edit Folder Properties…

3. Select the only available OS server "OS_DNP3".
4. Assign the AS objects created up to now (Diagnostic Typicals) "DNP3_Connect" and "DNP3_RTU" from the "AS Object Editor" via drag&drop to the plant area "Diagnostic".

NOTE

The green marks indicate changes, which have not yet been compiled and transmitted to the OS project.
6.4 Creating an Instance of the Type BitAlarm

First we will create an AS instance of the type “BitAlarm”; from chapter 7 on, further AS instances will be added.

Every time a new block and a new object is created, this means, according to the terminology used in the field of objects, we have created a new instance of the object. For this reason, we refer to the objects created in the following as "instances".

To create a new instance (or change an existing one), proceed as follows:

1. In the area "Components", select "DNP3_RTU".

2. Create a new instance.
   - context command > Create New AS Object…

3. Create a new instance of the type "DNPBitAlarm_V1" using any name.
4. Assign the newly created BitAlarm instance "DNP3_Switch_1" via drag&drop to the plant area RTU in the Plant Hierarchy.

5. Select the instance within "Plant View" and enter the previously defined "DNP3 start index" under the tab "Addresses". Value "0" as index for the raw value (RV).

6. Save the current status of the DBA project.  
   menu command > File > Save Project
6.5 Compile DBA project

Now the DBA project can be compiled. During this process, the DBA configuration is written into the OS.

1. Start the project compilation.
   
   **menu command > Run > Start Compilation**

2. The compilation process is started by pressing the button "Compile".

![Compilation process interface](image-url)
6.6 OS Runtime Test

Once the compilation has been completed without errors, the OS can be put into runtime.

SIMATIC Manager > OS_DNP3 > Open Object (WinCC Explorer) > Activate Runtime

The connection status can be viewed under the plant area "Diagnostic".

System configuration and communication test are now completed. The BitAlarm can already be tested in the plant area "RTU".

After that, further AS Instances can be created and tested.
7 Configuration of further AS Objects

One AS object of the type BitAlarm has been created in the previous chapters. In the following we will explain how further AS object types (analog value, command, count value, setpoint) can be configured.

We will have a detailed look into the individual steps for each object type in order to make understanding of context and relations easier. These typically consist of:

1. SINAUT object configuration
2. Creation of the required section of the user program if required
3. Configuration of the AS instance in DBA

Of course, the complete SINAUT configuration of objects can also be performed before the configuration of the instance in DBA is continued.
7.1 Creating the Object "Analog Value"

7.1.1 SINAUT - Object Configuration

1. Add the standard object type "Ana04W_S" from the TD7onTIM library in the SINAUT configuration tool.
2. Enable the channel "AnalogInput_1" as input with "Address [Byte]" = "10".
3. Subsequently determine the DNP3_Master as communication partner (refer to page 29). The DNP3 start index can be accepted without changes since Bin04B_S and Ana04W_S are assigned to different DNP3 object groups.
4. Save the project in order to generate the respective system data blocks and data blocks for the CPU and TIM. menu command > SINAUT > SAVE
5. Subsequently load these changes in the SIMATIC Manager onto the CPU and TIM. menu command > PLC > Download
7.1.2 DBA - Instance Configuration

1. In the DBA configuration tool, add a new AS instance of the type "DNPAnalogValue_V1" to the RTU in the AS view.
   
   Context command > "Create New AS Object…"

2. Assign the newly created analog value instance "DNP3_Poti" via drag&drop to the plant area RTU in the Plant Hierarchy.

3. Select the instance within the "Plant View".

4. Under the tab "Addresses", enter the value "0" as index for the raw value (RV).

5. Change the variation of the raw value to "32.4 – 16-Bit With Time".
6. Under the tab "Operation", change the indication "Value" of the line "Limit – Raw Value Upper Limit" to "27248".

7. The remaining limits can be optionally indicated at this point or adapted later in WinCC Runtime.

8. Switch on the logging for the process value (PV), tab > "Logged Tags", in order to archive the received and scaled analog value.

9. Compile the DBA project before you enable WinCC Runtime to test the entered analog value.
7.2 Creating the Object "Command"

In the following, a command object is configured. The execution of the command will switch on a LED for two seconds at the DI/DO module.

7.2.1 SINAUT - Object Configuration

1. In the SINAUT configuration tool, add the standard object type "Cmd01B_R" from the TD7onTIM library.

2. Enable the channel "CommandOutputByte" as output with "Address [Byte]"=5.

3. Set the "Command output time" to "20" x 0.1 s.

4. Subsequently, determine the "DNP3_Master" as communication partner (refer to page 29). The DNP3 start index can be accepted without changes since all objects inserted up to now are assigned to different DNP3 object groups.

5. Save the project in order to generate the respective system data blocks and data blocks for the CPU and TIM.
   
   menu command > SINAUT > SAVE

6. Subsequently, load these changes in the SIMATIC Manager onto the CPU and TIM.
   
   menu command > PLC > Download
7 Configuration of further AS Objects

7.2.2 DBA - Instance Configuration

1. In the DBA configuration tool, add a new AS instance of the type “DNPCommand_V1” to the RTU in the AS view.

2. Assign the newly created analog command instance "DNP3_Command_LEDonPuls" via drag&drop to the plant area RTU in the Plant Hierarchy.

3. Select the instance within the "Plant View".

4. Under the tab "Addresses", enter the value "0" as index for RCmd and STATUS.

5. For F (Feedback) set the value “1” (correspond to DI 4.1).

6. Change the "Mode" from RCmd to "OP – Operate Only".
7. Under the tab "Control", change the indication "Operation Type" for RCmd to "3 – LATCH ON".

8. Under the tab "Operation", set the option "Feedback Required" to "yes".

9. Subsequently, compile the DPA project in order to test the entered command and the feedback. Only after that, the WinCC Runtime can be enabled.
7.3 **Creating the Object "Counter"**

In the following, a count value object is configured, which is incremented in a two-second interval.

### 7.3.1 SINAUT - Object Configuration

1. In the SINAUT configuration tool, add the standard object type "Cnt01D_S" from the TD7onTIM library.
2. Enable the channel "Counter_1" as data block "DB" with "DB-No. = 30".
3. Subsequently, determine the "DNP3_Master" as communication partner (refer to page 29). The DNP3 start index can be accepted without changes since all objects inserted up to now are assigned to different DNP3 object groups.
4. Save the project in order to generate the respective system data blocks and data blocks for the CPU and TIM.
   
   menu command > SINAUT > SAVE

5. Within the SIMATIC Manager, create the data block "DB30" in the hierarchy folder "Blocks" of the CPU.
   
   context command > Insert New Object > Data Block

6. The data block DB30 contains an INT value named "DB_count". 

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Type</th>
<th>Initial Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16.0</td>
<td>DB_count</td>
<td>INT</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>17.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
7. Also in the block area of the CPU, create the organization block "OB35".
   *context command > Insert New Object > Organization Block*

8. Subsequently, open the block "OB35" by double-clicking on it and enter the
   AWL code that stands next to it.

9. Load the modified and added (system-) blocks in the SIMATIC Manager onto
   the CPU and TIM.
   *menu command > PLC > Download*
7 Configuration of further AS Objects

7.3.2 DBA - Instance Configuration

1. In the DBA configuration tool, add a new AS instance of the type "DNPCounter_V2" to the RTU in the AS view.

![Single Instance Editor](image)

2. Assign the newly created count value instance "DNP3.Counter" via drag&drop to the plant area RTU in the Plant Hierarchy.

3. Select the instance within the "Plant View".

4. Under the tab "Addresses", enter the value "0" as index for FLAG, FV and RV.

![DBA Instance Configuration](image)

5. Subsequently, compile the DBA project in order to test the entered count value. Only after that, WinCC Runtime can be enabled.
7.4 Creating the Object "Setpoint"

7.4.1 SINAUT - Object Configuration

1. In the SINAUT configuration tool, add the standard object type "Dat12D_R" from the TD7onTIM library.

2. Enable the channel "DataOutput" as data block "DB" with "Data Type REAL, Number = 1" and "DB-No. = 30". As the count value has already been stored in DB30, you can select "Address [Byte] = 2".

3. Accordingly, data block "DB30" is to be extended by the setpoint of the type "REAL".

4. Subsequently, define the "DNP3_Master" as communication partner (refer to page 29). The DNP3 start index can be accepted without changes since all objects inserted up to now are assigned to different DNP3 object groups.

5. Add the standard object type "Dat12D_S" from the TD7onTIM library. It is required for the feedback of the setpoint to the OS.
6. Enable the channel "DataInput" as DB and configure its "Input address" analogously to the channel DataOutput of the "Dat12D_R" object.

7. Determine the "DNP3_Master" as communication partner (refer to page 29).

8. For Dat12D_S of the "DNP3 start index", select the value "4". "Dat12D_S" is in the same DNP3 object group as "Ana04W_S". "Ana04W_S" reserved the indexes 0 to 3.
9. In "TIMs with TD7onTIM > All Destination Subscribers" change the conformity level for the "DNP3 Master" to level 5. This supports the transfer of the REAL setpoint to DNP3.

10. Save the project in order to generate the respective system data blocks and data blocks for the CPU and TIM.
    
    *menu command > SINAUT > SAVE*

11. Subsequently, load these changes in the SIMATIC Manager onto the CPU and TIM.
    
    *menu command > PLC > Download*
7.4.2 DBA - Instance Configuration

1. In the DBA configuration tool, add a new AS instance of the type "DNPSetpoint_V1" to the RTU in the AS view.

2. Assign the newly created setpoint instance "DNP3_Setpoint" via drag&drop to the plant area RTU in the Plant Hierarchy.

3. Select the instance within the Plant View.

4. Under the tab "Addresses", use the value "0" as "Index" for RSP and STATUS, according to the "DNP3 start index" of the "Dat12D_R" instance. Set the index of the feedback (RF) via the "Dat12D_S" instance to "4".
5. Additionally, for RF, change the "Group" to "32 – Analog Input Event" and the "Variation" to "32.7 – Single Precision Floating Point Value with Time".

6. Finally, compile the DBA project in order to test the entered setpoint. Only after that, WinCC Runtime can be enabled.

### 7.5 OS Runtime

If the compilation has been completed without errors, the OS can be put into runtime.

*SIMATIC Manager > OS_DNP3 > Open Object (WinCC Explorer) > Activate Runtime*
8 Literature

8.1 Bibliographic References

The following list is by no means complete and only provides a selection of appropriate sources.

Table 8-1: Supplementary documentation

<table>
<thead>
<tr>
<th>Manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. SIMATIC PCS 7 TeleControl Installation and Configuration Manual</td>
</tr>
<tr>
<td>11/2010</td>
</tr>
<tr>
<td>ASE03374108-01</td>
</tr>
<tr>
<td>2. SIMATIC PCS 7 TeleControl DBA User Manual,</td>
</tr>
<tr>
<td>11/2010,</td>
</tr>
<tr>
<td>ASE03374112-01</td>
</tr>
<tr>
<td>3. SIMATIC PCS 7 TeleControl Library Objects,</td>
</tr>
<tr>
<td>11/2010,</td>
</tr>
<tr>
<td>ASE03374112-01</td>
</tr>
<tr>
<td>4. SIMATIC PCS 7,</td>
</tr>
<tr>
<td>TeleControl Software V7.1 SP2</td>
</tr>
<tr>
<td>TeleControl - ReadMe.wri</td>
</tr>
<tr>
<td>5. SIMATIC NET SINAUT DNP3 System Manual,</td>
</tr>
<tr>
<td>02-2011,</td>
</tr>
<tr>
<td>C79000-G8900-C253-01</td>
</tr>
<tr>
<td>6. PCS 7 TeleControl DNP 3 Device Profile Document</td>
</tr>
<tr>
<td>7. SIMATIC PCS 7 TeleControl DBA Type Editor Function Manual,</td>
</tr>
<tr>
<td>11/2010,</td>
</tr>
<tr>
<td>ASE03374112-01</td>
</tr>
</tbody>
</table>

8.2 Internet Links

The following list is by no means complete and only provides a selection of appropriate sources.

Table 8-2

<table>
<thead>
<tr>
<th>Topic</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>\2\ Siemens Industry</td>
<td><a href="http://support.automation.siemens.com">http://support.automation.siemens.com</a></td>
</tr>
<tr>
<td>\3\ Online Support</td>
<td></td>
</tr>
</tbody>
</table>
9 History

Table 9-1

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1.0</td>
<td>05/2012</td>
<td>First issue</td>
</tr>
<tr>
<td>V1.1</td>
<td>11/2012</td>
<td>Revision Chapter 7.2</td>
</tr>
</tbody>
</table>